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Your Official Guide to the
Skillbusters:  Mystery at Wellsley Manor
Demonstration Program

Overview

Thank you for taking the time to review this demonstration version of
Skillbusters:  Mystery at Wellsley Manor.  If you are brave enough to enter
Wellsley Manor, you will enter into a fun and educational environment that
will help you improve your student�s keyboarding skills.

  Skillbusters provides your students with a mystery to solve as they
improve their keying skills.  The mystery, while providing fun, helps develop
critical thinking skills as students sift through clues they earn to determine
which are relevant and which are red herrings as they strive to arrive at the
correct solution.

The Skillbusters program is set inside Wellsley Manor.  Students key their
way through a variety of games to earn clues and solve mysteries.  If students
choose to play without a mystery, they will receive rewards other than clues
for winning the games.  A user-friendly interface lets students begin using the
software almost immediately.  And detailed, context-sensitive help is always
available.

The first time a student logs in, the program takes the student to the
pretest.  Here, students must key three one-minute timed writings, and their
average GWAM must meet or beat the goal set by the instructor in order to
play the games.  Students not meeting that goal GWAM are taken to the
Workout Room for additional practice.

After passing the pretest, and on subsequent logins, students are given the
option to play with or without a mystery (and to resume a mystery in
progress or start a new mystery if the bookmark is active).  When beginning a
new mystery, students are prompted to click on the clock in the Foyer to
enter the hidden closet, where James Wellsley presents the mystery and sends
the students out to get clues.  Clues can be earned in any of the game rooms
in Wellsley Manor:  Library�Trivia; Kitchen�Mouse Clues (CD-ROM
version only); Media Room�Baseball (CD-Rom version only); Stairs�Race;
Parlor�Concentration.

In addition to the game rooms, students can also enter the Workout Room
for additional keying practice using drill lines and timed writings.

Periodically, students will fall into �traps� and be required to key three
one-minute timed writings to determine a new goal GWAM.  By default,
traps occur every 45 minutes that the student is in the program; the trigger
time can be changed in instructor utilities.
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The instructor utilities provide several options that let you customize the
Skillbusters keyboarding software.  For example, you can change a particular
student�s preferences and establish class settings.  The instructor utilities also
provide the capability to view reports and graphs, set the data location, and
change your password.

Altered Functions

This section lists the features of the software that have been altered for this
demonstration version of Skillbusters.

1. The standard login and pretest are bypassed.

2. Only one game, Trivia, is active, and it contains only three timed writings
and 15 trivia questions.

3. There is only one mystery; there are ten in the full program.

4. Traps are disabled in the demonstration program.

5. All printing and saving functions are disabled.  The bookmark feature is
also disabled.

6. In the Instructor Utilities, you can view many of the options, but cannot
make any changes.

7. All sound, except the timer �ding�, has been disabled in the demonstration
program.  In the full program that delivers on floppy disks, there are a
minimal number of audio cues.  In the full program that delivers on CD-
ROM, there are audio voice clips added that allow the characters to
�speak�.  In the full program, there is an option in the Preferences screen
to turn the sound off.

Minimum System Requirements

The following minimum system requirements are necessary to run the
Skillbusters demonstration software.

Windows

486DX/66 Mhz processor
8 MB required, 16 MB recommended
High density 3.5" floppy drive; 40 MB hard drive with 14 MB free
640x480 graphics with 256 colors (super VGA)
101-key keyboard or equivalent; mouse
Sound card optional
Windows 3.1, Windows 95, 98, or NT
Novell 3.11 or higher network
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Macintosh

Macintosh with 66 Mhz 68040 processor (LC 475 or better)
12 MB required, 16 MB recommended (6.5 MB free memory)
High density 3.5" floppy drive; 80 MB hard drive with 14 MB free
640x480 graphics with 256 colors
Apple keyboard II (or equivalent), mouse
System 7.5 or higher
AppleShare 2.0 network or higher or Ethernet network

Installation Procedure

To install the Skillbusters demonstration program on your hard drive,
follow the instructions below.

Windows

1. Insert the Skillbusters demo program disk into the floppy disk drive.

2. Using Windows 3.1, choose Run from the File menu in the Program
Manager.  With Windows 95, click the Start menu and choose Run.

3. Key a:\setup and tap Enter.

4. Follow the instructions that appear on the screen to complete the installa-
tion process.

Macintosh

1. Insert the Skillbusters Demo program disk into the floppy disk drive.

2. Double-click on the disk to open the disk window, if necessary.

3. Double-click the installation icon to start the program.

4. Follow the instructions that appear on the screen to complete the installa-
tion process.

Getting Started

Once you�ve completed the installation, feel free to explore the functions
on your own, or follow along using this guide.

Start

The SkillDemo icon takes you to the start screen where you can choose to
visit either the Instructor Utilities or the main student program.  You can
always reenter by clicking SkillDemo again to explore the other option.

   If you want to visit the student program, you need to click on the Login
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button.  If you want to see the Instructor Utilities program, click the Instruc-
tor Utilities button.  Click the Login button now.

Login

For demonstration purposes, you merely need to click the Start Demo
button.  No records are kept of your session and you cannot enroll any new
users.  Once you have clicked Start Demo, you will go to the Pretest screen.

Pretest

In the full program, a student must first take a Pretest before entering
Wellsley Manor.  There is a minimum GWAM and accuracy rate that must be
met in order to access the games.   The default is set at 25 GWAM and 80%
accuracy.  Both of those numbers can be changed in the Instructor�s Utilities.
In the demo version, you continue by tapping Enter.  Your goal GWAM is
preset to the default.

Welcome

The Welcome screen displays two button choices: New Mystery and
Games Without Mystery.  If you would like to experience the mystery and
earn clues then click the New Mystery button.  If you prefer to play games
without earning clues then click the Games Without Mystery button.  A
third choice would appear in the full program, Resume Mystery.  Students
choose to continue any mystery that is already in progress by clicking the
Resume Mystery button.  Click the New Mystery button now.

Main Screen

The main screen in Skillbusters is the foyer of Wellsley Manor.  From here,
you can enter the various rooms to play games, the workout room to im-
prove specific skills, or the closet, where the details of the mystery are
outlined and the solution is revealed.  Since you clicked the New Mystery
button on the previ-
ous screen, you will
see James directing you
to click on the clock
to enter the closet.

In the full program,
a student can enter
one of the six rooms
to play a keyboarding
game or to work on
specific drills and
timed writings.   Each
game has an inherent
speed or accuracy
focus.
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Closet

The closet is where James sits waiting for you to arrive so that he can share
the information that he has gained for each mystery.  You are prompted to
enter the closet every time you start a new mystery.  You get information
about the mystery by clicking on the note pad in his hand so you can read his
notes.  In addition, you can click on the Bios notebook lying on the shelf to
read short biographies on each of the servants and the members of the
household.  No one is above suspicion.

Go into the library (see below) and play the game until you have earned a
clue.  Then return to the closet.  A Solution box will then be present.  Click
on the Solution box to bring up a solution grid.  The grid contains four pull-
down menus of potential solutions.  In the full program, a section of the grid
is �unlocked� only
after a clue has been
earned from that
category.

In the demonstra-
tion version, the entire
grid is unlocked.  The
solution to the
mystery in the demo is
Georgetown, Cayman
Islands, Airplane,
scuba diving with
stingrays.

When you exit the
closet you will be back
in the foyer where you can choose a room to enter.

Playing the Games

The only active game in the demo program is Trivia.  But you are encour-
aged to enter all of the rooms to meet the characters in each room and see the
game rules.

Library�Trivia

When you enter the library, you will encounter Jackson, the butler, who
will undoubtedly challenge you to a game of Trivia.  Go ahead, accept the
challenge and click on the library table.

To play the game of Trivia, you will first be given a 1 minute timed
writing to key.  If you succeed in keying at or above your goal GWAM
(which is set at 25 in the demo), you will be able to pick three trivia questions
to answer.  The Trivia questions come from 5 categories.  You are given three
potential answers.  You will be told immediately if you were correct or not.
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Each correct Trivia
question earns you
1,000 points.

After you have
answered 3 Trivia
questions, you will be
given another 1
minute timed writing
to key.   Keying at or
above 25 GWAM
earns you 3 more
Trivia questions.  You
must earn 7,000 points
to win a clue.  If you
fail to key any 5 timed
writings at or above 25 GWAM, you will lose that game and all your Trivia
points, and you must start again.

Take some time now to play the Trivia game and earn some clues.  Once
you�ve earned a clue, you may want to key it in your Clue Book (see page
11).  Then return to the closet and see if you can solve the mystery.  Remem-
ber, you access the closet, and all other rooms, from the foyer.

Media Room�Baseball

Upon entering the Media Room you will encounter Walter, the chauffeur.
Baseball is played from here in the CD-ROM version of the full program by
clicking on the television screen.  Go ahead and click on the television screen
now to see the baseball field.

Baseball is set up like an actual baseball game in process.  It is the bottom
of the ninth inning and the student�s team is down 2-0 with two outs.  The
student must key a series of timed writings at or above his/her goal GWAM
to get walks or hits and score runs.  The student must score three runs,
without making an out, to win the game.

Baseball challenges the student to key faster by rewarding efforts that
exceed goal GWAM with better batting results.  A student keying at only the
goal GWAM earns a ball for each keying.  But by keying at goal + 1, the
student earns a hit that gets the runner to first base.  Keying at goal + 2,
allows the batter to get to second base on that effort, and of course moves any
current baserunners ahead by the same number of bases.  When a student
shows tremendous keying, earning a GWAM of the goal + 4, the runner
earns a homerun, with the fans showing their appreciation for the effort.
However, fast keying is not enough.  This game has an ambitious default of
only 2 errors in any keying.  The default can be changed in the Instructor�s
Utilities.
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Parlor�Concentration

When you enter the Parlor, you will find Mrs. Martinez, the housekeeper,
just finishing tidying up.  She will probably suggest you play a game of
Concentration.  She doesn�t realize the game wasn�t included in the demo.
But you can click on the game and go to the instructions screen.

The emphasis of Concentration is accuracy.  The student is presented drill
lines to key for 15 seconds, at or above the accuracy rate set by the instructor.
If the student succeeds, s/he has the opportunity to pick two cards from the
game board to match the pictures on the backs of them.  If the cards match,
the student will be able to select two more cards; if they do not match, the
student will be presented additional drill lines to key.  This continues until
the student wins the game by clearing the entire game board.

Kitchen�Mouse Clues

When you enter the kitchen, you will be greeted by Gus, the Wellsleys�
somewhat temperamental cook.  He�s especially grumpy because a mouse
keeps getting into his grain sacks.  He is waiting for a student that will play
Mouse Clues and help him catch the mouse.  Unfortunately you can�t help
him because Mouse Clues is not included in the demo.  You can take a quick
peek in the mouse hole to get a glimpse of what he is up against.

(This game is available in the CD-ROM version of the program only.)
In this game, students are challenged to sustain their keying speed over

longer periods of time.  Each time students succeed in keying at or above their
goal GWAM, they move to the next level, and has to sustain that GWAM for
a longer time.  Each time students do not succeed, the mouse breaks into
another bag of grain.  Students are given two opportunities to pass each level.
If they miss twice, they move back to the prior level with the shorter time
frame.  The time increments can be set for 15-30-45-60 seconds or 30-60-90-120
seconds.

Stairs�Race

When you click on the door to the attic stairway, you will be �trans-
ported� upstairs and met by Jenny, James�s little sister.  Jenny was thinking of
checking the attic for clues, but is relieved that you have arrived to try
instead.  She is unaware of the fact that the Race game is not available in the
demo.  You can click on the stairs to see the game instructions for Race.

The goal of this game is for the student to increase keying speed in a series
of short spurts.  Initially, the student is given 15 seconds to key, with control,
as much as possible of the text on screen.  The student is then challenged to
key the same amount of text in 12 seconds, and then in 10 seconds, to climb
to the top of all three flights of stairs.

Each time a student falls short on a particular level, s/he gets sent back to
the previous level to try again before moving on.
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Workout Room

When you enter the Workout Room, you will find Anissa Jefferson amid
many pieces of exercise equipment.  You can roll the mouse over each one to
see the drill or timed writing that it would open.  However, much to Ani�s
disappointment, you cannot actually try any of them in the demo.

Students can use this area to work on specific areas of weakness.  There are
five sections of drills, each of which has a specific focus.  They include
Alphabetic Sentences, Balanced Hand, High Frequency Words, Letter
Emphasis Sentences, and Specific Finger/Row Emphasis.  In addition, three-
and five-minute timed writings are also available.

Menu Bar

Clue Book

The first item on the menu bar (moving from left to right) is
the Clue Book.  When a student is playing with a mystery, the
initial mystery information revealed in James�s notebook, all the

clues that are earned, and any thoughts the student would like to record, can
be keyed here.  In the full program, the Clue Book text can be printed, or it
can be used for on-line reference.  It can be particularly handy when faced
with the solution grid in the closet where the student needs to select the
answers to the four questions James asked at the beginning and solve the
mystery.

Help

The students can access help from anywhere within Wellsley
Manor, except in the middle of playing a keyboarding game.
The Help is context sensitive and will take the student to the

screen that matches the student�s location.  Full rules for all of the games are
included in the Help.  There is also a Contents screen where students can
choose additional Help topics.

Options

The Options icon is a pull-down menu for three additional
screens:  Preferences, Student Log, and Report.

Preferences

Once a student has passed the Pretest, s/he is taken to the screen showing
the current Preferences settings.  Many items can be changed by the student,
unless the lock has been applied in the Instructor Utilities.  Those items
include:  backspace allowed or not, mystery on or off, bookmark on or off,
and sound on or off.  Once the student has determined that the Preference
settings are satisfactory, s/he should click the Done button to continue.
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Student Log

Choosing Log from the Options menu allows students to see a record of
their work in Skillbusters.  The log displays the names of games played, how
much time was spent in each session, and any wins.  It also records the time
spent in the Workout Room on drills and timed writings.  In the full pro-
gram, the log can be printed.

Student Report

Choosing Report from the Options menu allows students to see a record of
the scores they have earned in the Pretest, Traps, and timed writings.  These
scores can be displayed in lists or graphs.  In the full program, these scores can
be printed.

Instructor Utilities

This is the instructor�s program that allows you to view and print student
records, in addition to altering goal GWAM and accuracy rates.  In the demo,
you can view all of the Instructor Utilities screens, but you cannot make any
changes.

Set Data Location

Click this button and you will see the screen that shows the current
student data path.  This is the location where all student records for
Skillbusters must be stored.  Since the demo is not actually saving any records,
this path cannot be altered.  This screen also lets you determine if you wish to
let students enroll themselves from within the Skillbusters program.  If you
choose Disallow student enroll, then you will need to enroll all students
through the Student Information screens.

Class Information

Clicking this button takes you to the screen that allows you to create new
classes or edit or delete current ones.  You can also view the Preference settings
for each class by clicking the Prefs button and then the class name in the Class
List.  In the demo, we have already created a single class for you, Class1.  You
can view the student records for that class by clicking first on the Records
button, and then clicking the class name.

Student Information

Clicking on Student Information takes you to the screen that allows you
to create new students, within the classes you already created, or to edit or
delete current students.  You can also view the Preference settings for each
student by clicking the Prefs button and then the student name in the Student
List.  In the demo, we have already created a single student in Class1 for you,
Guest.  You can view each student�s records for that class by clicking first on
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the Records button, and then clicking the student name.  You can also view
each student�s log by clicking first on the Logs button, and then clicking the
student name.

Change Instructor Password

If you want to change the instructor password for any reason, you would
click on the Change Instructor Password button.  Always be sure to write
the password in a safe location where it cannot be lost.

Technical Support Hotline

If you have difficulty using this demonstration version of Skillbusters, a
Technical Support Hotline is available to you at 1-800-543-0453, 9:30 a.m. to
4:30 p.m. EST.  If a problem occurs, please check all hardware to make sure it
is working properly.  If the hardware is working properly and the problem
appears to be software-related, call the number given.

Please have available the following information:

� The floppy disk containing the program

� A description of the problem

� Computer type, model, memory configuration, and video/audio setup

� Error messages (if any)

Please do not allow students to have access to the hotline number.  Hotline
specialists are not equipped to take orders or provide sales information.
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Odering Information
So, what did you think?  Are you ready to order?  Or do you have further

questions?

Secondary Schools

For more information, contact Customer Support at 1-800-824-5179.  If
you are ready to place an order for Skillbusters call Customer Service at 1-800-
354-9706, 8 a.m. to 6 p.m. EST using the following ISBN(s):

CD-ROM, Windows/Macintosh Site License/Network 0-538-68343-0

CD-ROM, Windows/Macintosh Individual License 0-538-68344-9

floppy disk, Windows Site License/Network 0-538-68345-7

floppy disk, Macintosh Site License/Network 0-538-68346-5

Postsecondary Schools

For more information, contact the Academic Resource Center at 1-800-
477-3692.  If you are ready to place an order for Skillbusters, contact your
bookstore or call Customer Service at 1-800-354-9706, 8 a.m. to 6 p.m. EST
using the following ISBN(s):

CD-ROM, Windows/Macintosh Site License/Network 0-538-68343-0

CD-ROM, Windows/Macintosh Individual License 0-538-68344-9

floppy disk, Windows Site License/Network 0-538-68345-7

floppy disk, Macintosh Site License/Network 0-538-68346-5

If you have further questions regarding Skillbusters, contact your ITP
representative, call 1-800-824-5179, or visit our web site at
http://www.swep.com/.
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